Tutorial

EDSVS
TUTORIAL

Chapter

This tutorial comes from the EDC Simulations seminar. It provides a good
example of the use of the driver input tables. In particular, it illustrates how the
driver tables use linear interpolation to compute the current steer angle.

The goal of this tutorial is simply to make the simulated vehicle follow the
desired path. Only steering is required, so the scope is limited, but extremely
useful.

Like all EDSVS events, the procedures involve the following basic steps:

* Create the vehicles

* Create the environment

» Execute the EDSVS event

* Review the EDSVS output reports

These basic procedures are described in detail in this tutorial.

[ NOTE! It is assumed that HVE-2D is up and running, and
that the user is familiar with HVE-2D’s basic features,
such as using HVE-2D’s dialogs and viewers, as well as
the HVE-2D Editors. The purpose of this tutorial is to
illustrate those features while setting up and executing an
EDSVS event.
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EDSVS Getting Started

Gefting Started

Asin other tutorials, before we get started with our current tutorial, let’s set the
user options so we’re all starting on the same page.

IS NOTE: In HVE-2D, alf options simply affect the appearance
in a viewer during Event or Playback mode.

ng However, in HVE, AutoPosition affects the data used in
the analysis. For example, if AutoPosition is On, the
vehicle position conforms to the local surface; otherwise, the
position is set by the Position/Velocity dialog. Obviously, the
resulting difference in initial conditions could substantially
change the event.

IS5 NOTE: Some of the following options are “Toggles” that
switch between two different modes. Make sure these
options are set correctly.

To set the initial user options, choose the following from the Options Menu:

> ON: Show Key Results

> OFF: Show Axes

> ON: Show Contacts

> QOFF: Show Velocity Vectors
> ON: Show Skidmarks

> OFF: Show Targets

> ON: AutoPosition

> Units equals U.S.

> Render Options:

» Show Humans as Actual

» Show Vehicles as Actual

* Phong Shading Mode

* Complexity equals Object

* Render Quality equals 5

» Texture Quality equals /

* Anti-aliasing equals /
The remaining options will automatically initialize to their default conditions.
We’re now ready to proceed with the tutorial.

Our goal is to use EDSVS to drive a 1997 Ford Explorer along the path
described in Figure 5-1, shown on the following page. This tutorial shows us
how to perform this simulation.
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Figure 5-1 Path for EDSVS Simulation Tutorial
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Creating the Vehicle

Now let’s add the vehicle to our case. The vehicle is a dark green 1997 Ford
Explorer:

> If the Vehicle Editor is not the current editor, choose Vehicle
Mode. The Vehicle Editor is displayed.

> Click Add New Object. The Vehicle Information dialog is
displayed. The Vehicle Information dialog allows the user to
select the basic vehicle attributes according to 7ype, Matke,
Model, Year and Body Style.

5> NOTE: The Vehicle Information dialog also allows you to
edit the Driver Location, Engine Location, Number of
Axles and Drive Axle(s). The Ford Exploreris a 4-wheel
drive vehicle, but we’re going to select 2-wheel drive for
the tutorial.

> Using the option buttons, click each button to choose the
following vehicle from the database:

* Type = Sport Utility
* Make = Ford
* Model = Explorer
* Year = 1995-1999
* Body Style = 4-Door
* Drive Axles = Axle No. 2
> Click OK to add Ford Explorer 4-Dr to the Active Vehicles
list.

The Ford Explorer is displayed in the viewer, as shown in Figure 5-2.
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Figure 5-2 Ford Explorer 4-Dr, before editing.
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EDSVS Creating the Vehicle
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Figure 5-3 Vehicle Color
dialog, used for assigning the
vehicle color.

Editing the Vehicle

Next, we will edit the vehicle to change its color and weight. To edit the color,
perform the following steps:

> Click onthe CG (the CG may be hiddenunder the seat or other
interior object; however, the CG icon is located at the vehicle
CG; therefore, if you click at the intersection of lines
connecting the exterior balls (left-right and front-rear), you
will select the CG) and choose Color. The Vehicle Color
dialog is displayed (see Figure 5-3), showing the vehicle’s
current color (the small black square, or ot spot, inthe color
wheel) and intensity (the arrow inthe intensity slider). Click on
the hot spot and drag it to the middle of the green area. To
darkenthe vehicle, click on the intensity slider and drag it from
the right end of the slider towards the middle.

[I=5° NOTE: The color chip on the left shows the current color.

> When the color is darkened to your liking, close the dialog by
clicking the close button on the upperright corner of the dialog.

[I=53° NOTE: The vehicle’s apparent color may be slightly
misleading because the vehicle is translucent when
displayed in the Vehicle Editor. The actual color will be
used whenever the vehicle is displayed during Event and
Playback mode.
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Total Weight (b]: | 4405.000
Mazz [lb-sec™24n] ; IW
Sprung lnertia [lb-sec”24n) - Rall ; IW
Pitch lb-sec™2n): [ 3194020
Yaw [lb-sec™2-in] ; IW
#Z Product Of Inertia [lb-sec™2-in] : IW

Ok, | Cancel ‘

Figure 5-4 Vehicle Inertias dialog, used for editing the
current weight and yaw inertia. The values in this
dialog are customized for this simulation.

Next, let’s change the weight. Perform the following steps:

> Click on the CG and choose Inertias. The Inertias dialog is
displayed (see Figure 5-4), and we’re ready to change the
vehicle’s weight.

[ NOTE: Only total weight and yaw inertia is used by the
3-DOF EDSVS calculations.

> In the Total Weight text field, replace the existing weight,
4295, with the measured value, 4405 1b.

[5° NOTE: The dialog might display 4294.836, or similar
number, because the weight is actually divided by the
current gravity constant and stored as mass. Extra
precision results when the mass is multiplied by the
current gravity constant and redisplayed.

> Press OK to accept the weight value.
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Creating the Environment

Now, let’s add the environment:

> Choose FEnvironment Mode. The Environment Editor is
displayed.

> Click Add New Object. The Environment Informationdialog is
displayed.

> Using the Location Database combo box, choose Beaverton,

Oregon, USA. The latitude, longitude and GMT (hours from
the prime meridian) are displayed for the selected location.

> Enter the date and time of the incident we are studying,
8-8-97 and 1230, respectively.

> Enter the angle from frue north to the earth-fixed X axis in our
environment, 165 degrees.

[[g NOTE: The Latitude, Longitude, GMT, Date/Time and
angle from true north are used to position the sun in the
scene. This is, of course, important because the sunis
the primary light source for the scene.

> To add the environment geometry file to our case, click on
Open. The Environment Geometry File Selection dialog is
displayed.

> Click on the File Format option list and choose /13d Files. A
list of environment geometry files using the .h3d file format is
displayed in a list box. Double-click on EdsvsTutorial.h3d to
choose the environment file and remove the dialog.

> Press OK.

The sclected environment is added to our case and displayed in the
Environment Viewer (see Figure 5-5). Use the viewer thumb wheels and/or
manipulators to view the scene.

Saving the Case

Now that we’ve created all the objects (vehicle and environment) for our case,
let’s save the case file.

> Click on the File menu and choose Save. The Save-as File
Selection dialog is displayed.
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Figure 5-5 Environment used for our EDSVS tutorial.

5> NOTE: The Save-as dialog is displayed because the
case has not been saved previously, so we need to enter
a filename.
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> Place the mouse cursor in the Case Title text field and enter
EDSVS Tutorial Case.

5> NOTE: The Case Title is displayed as a heading on all
printed output reports.

> Place the mouse cursor in the Filename text field and enter
EdsvsTutorial.

> Click SAVE. The current case data are saved in the
HVE2D/supportFiles/case subdirectory.

5> NOTE: Saving the file occasionally is a highly
recommended practice.
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Creating Events

As mentioned at the outset of the tutorial, we are going to simulate a vehicle
traveling along a pre-determined path to lear more about the use of HVE-2D driver
tables. To create the event, perform the following steps:

> Choose Event Mode. The Event Editor is displayed.

> Click Add New Object. The Event Information dialog is
displayed.

> Select Ford Explorer 4-Dr from the Active Vehicles list.

> Select EDSVS from the Calculation Method options list.

> Enter a name for the event, Steering Maneuver.

5> NOTE: HVE-2D will append the name of the calculation
method to the event name, thus the complete event
name will become “EDSVS, Steering Maneuver.”

> Press OK to display the event editor.

Now, we’re ready to set up the event.

> Using the Event Editor dialog, select Ford Explorer 4-Dr from
the Event Humans & Vehicles list, then choose Set-up from the
menu bar and select Position/Velocity. The Explorer is
displayed at the earth-fixed origin.

> (lick on the vehicle’s X-Y manipulator (see Figure 5-6), wait
forit to turn bright yellow (indicating it has been selected), and
drag it to its initial position, X=-30 ft, Y=-10 ft. Click the
yaw manipulatorand rotate it to its heading angle, O degrees.

[[g NOTE: To select the X-Y manipulator, the viewer must be
in Pick mode, as indicated by the highlighted arrow in the
upper right corner of the viewer (see Figure 5-6).

5> NOTE: Be sure to keep the mouse button depressed
while you drag the manipulators.
5> NOTE: Adjust the viewer by dollying back (using the Dolly
thumb wheel) until you can see the entire course.
5> NOTE: If you can't position the vehicle at the exact
coordinates, simply enter them in the dialog (in fact, it’s
often easier to directly enter the coordinates using the
dialog, especially for heading angle).
> Click the Velocity Is Assigned checkbox. Enter the initial
velocity, 20 mph, then click Apply.
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Figure 5-6 Vehicle positioning using the HVE-2D Event Editor. The manipulators can be
used to drag and drop the vehicle into position.

5> NOTE: When entering coordinates and velocities using
the Position/Velocity dialog, remember to press <Enter>;
otherwise, the values will not be assigned.

The vehicle initial conditions are now established. Let’s enter the driver
controls. But, before we enter the steer angle data, let’s be smart: Although we
could simply find the steer angles by trial and error, instead we’ll use a simple
formula to arrive at a very good estimate. From the vehicle wheelbase and
desired path radius, it can be shown the required steer angle is approximated
by:

&= arctan(Wheel bas%adius)

5> NOTE: The accuracy of this estimate is normally an
acceptable initial estimate unless the vehicle is
sideslipping.
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EDSVS Creating Events

Noting the wheelbase of the vehicle is 112 inches and the desired path radius is
50 feet (600 in), the required steer angle is about 11 degrees at the wheels.

5> NOTE: An initial attempt using 11 degrees caused the
vehicle’s path to be too large. We'll use 11.25 degrees in
our table.

To enter the steer angles, perform the following steps:

> Click on the Set-up Menu and select Driver Controls. The
Driver Controls dialog appears and the Steering Table is
displayed.

> Clickonthe 7able Is option list and choose the A¢ Ax/e option.
> Enter the steer angles for the front wheels, as shown below:

Table 5-1 Steering Table for the EDSVS, Steering Maneuver event.

Steer Angle at Axle (degrees)

Axle 1, Right Axle 1, Left
0.50 0.00 0.00
0.60 11.25 11.25
9.50 11.25 11.25
10.00 -11.25 -11.25
12.65 -11.25 -11.25
13.75 0.00 0.00

> Press OK to accept the steering table.

This event lasts more than 5 seconds. To prevent premature termination, let’s
increase the default maximum simulation time.

> Click on the Options menu and choose Simulation Controls.
The Simulation Controls dialog is displayed.

> Edit the Maximum Simulation Time, changing it from 5 to 20
seconds.

> Press OK to update the simulation controls.
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Figure 5-7 Key Results Variable Selection dialog, used for
selecting variables to be displayed inthe Key Results window.
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Since our goal for this event is to follow a desired path, let’s look at some Key
Results during execution:

> If Key Results windows are not displayed, choose Show Key
Results from the Options menu.

> Dragthe Key Results windows to a convenient location, where
they do not block the view but still allow us access to the
viewer thumb wheel controls (in case we want to change the
view).

> Click on Select Variables in the Ford Explorer 4-Dr Key
Results window. The Variable Selection dialog for Ford
Explorer 4-Dr is displayed.

Let’s add Wheel Fx, Fy, Fz and Steer Angle to the Key Results window:

> Choose Wheels, Axle 1, Right from the variable output groups
list. The Variable Selection list for the right front wheel is
displayed (see Figure 5-7, above).
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> Select Fx, Fy, Fz wheel forces and Delta (whi) (Steer Angle)
from the list.

5> NOTE: The above procedure adds the forces for the right
front wheel only; you might wish to add the variables for
the remaining three tires.

> Press OK to add the selected variables to the list.

Now, we’re ready to execute the event.

> Using the Event Controller, click Play to execute the event.
Allow the event to run until completion at t = 20 seconds.

The EDSVS event is shown at time, t = 3.10 seconds in Figure 5-8. Note
the vehicle travels within 2 feet and 2 degrees of each path position
defined in Figure 5-1.

[[g NOTE: While the event is executing, watch the current
results (especially the XY path coordinates and heading
angle) in the Key Results windows.

We have now completed the event.
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Figure 5-8 HVE-2D Event Editor executing the EDSVS Event.

Viewing Results

Now that we have produced our EDSVS simulations, let’s take a detailed look
at the results. The Playback Editor is used for reviewing and printing reports
for cach event in the current case, as well as for producing video output.
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EDSVS produces the following reports:

» AccidentHistory - A table of initial and final positions and velocities
» Messages - A list of messages produced by the current run
* Program Data - A table containing program control information

» Trajectory Simulation - A visualization of the event, displayed at a
user-sclectable time interval

Variable Output - A table containing time-dependent simulation
results

» Vehicle Data - A series of tables containing the vehicle data used by
EDSVS

To view the output reports, we need to be in Playback mode:
> Choose Playback Mode. The Playback Editor is displayed.
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Report Windows

The reports listed on the previous page are displayed by selecting Report
Windows. Each Report Window contains an individual report.

Report Window E

Active Events

Window M ame
|EDS‘J5, Steenng Manewwer

Select Output
|.-’-‘-.|:|:i|:|ent Hiztary j

| ] | Cancel |

Figure 5-9 Report Window Information
dialog, showing the name of the
event(s)in the current case.

To view the reports produced by the EDSVS, Steering Maneuver event,
perform the following steps:

> Click Add New Object. The Report Window Information
dialogis displayed, as shownin Figure 5-15, and includes a list
of the active events (EDSVYS, Steering Maneuver is the only
event in this tutorial). The Report Window Informationdialog
also includes the user-editable Report Window Name text field
and Selected Output option list.

> Select EDSVS, Steering Maneuver fromthe Active Events list.

> Click on the Selected Output option list and choose any of the
available reports.

> Press OK to display the report.

The selected report will be displayed in a resizable window. The following
pages illustrate the reports produced for the EDSVS, Steering Maneuver event.

5-16
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Accident History

The Accident History report displays the time and total distance traveled, as
well as position and velocity information for the start and end of the run.

42, Accident History-EDSYS, Steering Maneuver

ACCIDENT HISTORY

Total Distance Trawvelled [(£t): 475, 31
Time [sec): Z0.0003
Pozition Velocity
X T PEI V-tot u-wel w-wel Yaw Vel
(L] (L] [dedq) [mph) [mpl (mph]  [(deg/sec)
Initial: -30.00 -10.00 0.00 20.00 Z0.00 0.o0 0.00
Final: -259.87 -9.19 179.88 15.00 15.00 -0.00 0.00

o o

Figure 5-10 Accident History Report for EDSVS, Steering Maneuver.

To view the Accident History report for the EDSVS, Steering Maneuver event,
perform the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.
> Select EDSVS, Steering Maneuver fromthe Active Events list.

> Click on the Selected Output option list and choose Accident
History.

> Press OK.
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The Accident History report is displayed for the EDSVS, Steering Maneuver
event, as shown in Figure 5-10.

[ NOTE: The Accident History report and several other
reports contain more information than fits into the default
window size. Use the scroll bars or resize the dialog to
view the entire report.
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Messages

EDSVS produces a number of messages, depending on the outcome of the
event. For a complete list and explanation of the messages produced by
EDSVS, see Chapter 6.

: Messages : ED5SYS5, Steering Maneuver

-
MESSAGES

Ho Mezzages

Al H

Figure 5-11 Messages History Report for EDSVS, Steering Maneuver.

To view the Messages report produced by the EDSVS, Steering Maneuver
event, perform the following steps:

> Click Add New Object. The Preview Window Information
dialog is displayed.

> Select EDSVS, Steering Maneuver fromthe Active Events list.

> Click onthe Selected Outputoptionlistand choose Messages.

> Press OK.

The Messages report is displayed for the EDSVS, Steering Maneuver event, as
shown in Figure 5-11.
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Program Data

The Program Data report for EDSVS displays the simulation controls used for
the current event.

o Program Data-EDSYS. Steering Maneuver

GENERLL PROGRELM INFORMATION

EDSVWS Version No: 6. 50

SIMULATION CONTROLS

Max Simulation Time (sec): 20,0000
Trajectory Phase dt ([sec): 0.0200
Output Interwval (zec): 0.1000
Linear Term Vel (mph]): Z.00

-

2 1

Figure 5-12 Program Data Report for EDSVS, Steering Maneuver.

To view the Program Data report for the EDSVS, Steering Maneuver event,
perform the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.
> Select EDSVS, Steering Maneuver fromthe Active Events list.

> Click on the Selected Output option list and choose Program
Data.

> Press OK.

The Program Data report is displayed for the EDSVS, Steering Maneuver
event, as shown in Figure 5-12.
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Vehicle Data

The Vehicle Data report displays the vehicle data, tire data and driver control
tables for the EDSVS vehicle.

'-.'. Yehicle Data-ED5YS, Steering Maneuver

VEHICLE DATA B
Ford Explorer 4-Dr J
Owerall Length [(in): 186.75
Owerall Width (in): 69.00
CG to Front End (in): §4.75
CG to Rear End (in): -102.00
Theelbase [in): 112.00
Front Overhang (in): 32.91
Rear Owerhang (in): -41.54
CG to Front ixle (in): 51.54
CG to Rear Axle (in): -60.16
Front Trackwidth [in): £5.25
Fear Trackwidth [(in]: 55.50
CG Height Ahowe Ground (in): Z258.28
Lateral Load Xfer (*): 0.55
Mazz (lb-sec*Z/inj: 11.40
Weight (lbj: 4405.00
Total Yaw Inertia (lb-sec*Z-in): 37928.53
Sprung Yaw Inertia (lb-sec*Z-inj: 34406, 00
TIRE DiTa
Ixle 1 Axle 2
Peak Friction -
Right: 0.85 0.85
Lefr: 0.85 0.85

Slide Friction -
Right: 0.60 0.60
Left: 0.60 0.60

Slip @ Peak Mu (%/100) —
Right: 0.10 .10

Left: 0.10 0.10 ~
A 3

Figure 5-13 Vehicle Data Report for EDSVS, Steering Maneuver.

=1

To view the Vehicle Data report for the £ZDSVS, Steering Maneuver event,
perform the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.
> Select EDSVS, Steering Maneuver fromthe Active Events list.

> Click on the Selected Output option list and choose Vehicle
Data.

> Press OK.

A portion of the Vehicle Data report is displayed for EDSVS, Steering
Maneuver is shown in Figure 5-13.

5-20
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Variable Output

To view the Variable Output report for the ZDSVS, Steering Maneuver event,
perform the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.
> Select EDSVS, Steering Maneuver fromthe Active Events list.

> Click on the Selected Output option list and choose Variable
Output.

> Press OK.

The Variable Output report is displayed for the EDSVS, Steering Maneuver
event. The table is initially empty, so the next step is to select the
time-dependent results we wish to display in the table.

Variable Selection

The purpose of our EDSVS study is to make our vehicle follow a desired path.
To document the resulting path, as well as some other pertinent results, let’s
select the CG path coordinates and path radius from the Variable Selection
dialog.

> Click on Select in the Variable Output window. The Variable
Selection dialog for Ford Fxplorer 4-Dr is displayed, as
shown in Figure 5-14.

The Kinematics Output group is the default selection and the Kinematics
variable list is displayed. Let’s add X, Y, Yaw and Path Radius to the Variable
Output window:

> Select X, Y, Yaw and Radius from the list .
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Next, let add the right front tire forces and steer angle:

> Choose Wheels, Axle 1, Right, from the variable groups list.
The Variable Selection list is displayed.

> Select Fx, Fy, Fz and Delta (whl) from the variable list

5> NOTE: Feel free to add additional variables to the
Variable Output window.

> Press OK to add the selected variables to the Variable Output
window.
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Connechions

Ciivetrain

Crriver

Clear Selection I

Cancel |

Figure 5-10 Variable Selection dialog, used for selecting the
results displayed in the Output Report. The above variable list is

displayed after selecting the Wheels group and selecting Ax/e 1,
Right Side.

The Variable Output report for the EDSVS, Steering Maneuver event now
includes X.Y path coordinates and heading angle, path radius, and right

front Fx, Fy, Fz tire forces, steer angle, plus any other variables you may
have added (see Figure 5-15).
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Figure 5-11 Variable Output report for EDSV'S, Steering Maneuver, displaying the selected
results.
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Trajectory Simulation

Finally, let’s display a trajectory simulation for this event. To view the
Trajectory Simulation for the EDSV'S, Steering Maneuver event, perform the
following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.
> Select EDSVS, Steering Maneuver fromthe Active Eventslist.

> Click on the Selected Output option list and choose Trajectory
Simulation.

> Press OK.

The Trajectory Simulation viewer is displayed for the EDSVS, Steering
Maneuverevent (see Figure 5-16). The vehicle is shownat its initial position.

To visualize the motion, use the Playback Controller to perform the following
steps:

> Click Play (single right-arrow). The simulation begins and is
displayed at the current Playback output interval.
> Click Pause. The simulation stops.

> Click Reverse (single left-arrow). The simulation plays in
reverse.

> Click Rewind (left arrow with bar). The simulation returns to
the start.

> Click Advance to End (right arrow with bar) the simulation
advances to the end of the run.



Viewing Results Tutorial

& Traj 5im-ED5YS, Steening Maneuver

»

e ﬂ : Buli?

transY transX I TI[0 Zoom

Figure 5-12 Trajectory Simulation for EDSVS, Steering Maneuver, displaying the selected
results.
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Printing

The final step is to print the above reports. Printing reports is simple. All youdo
is choose a report and print it. For example:

> (lick on the dialog header of the Variable Output - EDSV'S,
Steering Maneuver report. Your selection is highlighted and
the Variable Output window pops to the top of the display (if it
isn’t there already), indicating it is the current window.

> (lick on the File menu and choose Print. The Print dialog is
displayed, allowing the user to select from several available
print options.

5> NOTE: Alternatively, you can click on the print icon in the
main menu bar.

> Press OK. The Variable Output report is printed on the system
printer.
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That’s all there is to it! You can print any other report using the same three
steps described above.

5> NOTE: The Print dialog provides several options. Refer to
the User's Manual for more information.

5> NOTE: For several reports it may be best to print in
landscape rather than portrait mode.

5> NOTE: The font size of both the printed reports and
screen display may be changed by clicking on the
Options menu and choosing Preferences. Use the Font
Size option list to change the size.



